## Table of Contents

### Getting Started
- System Requirements ................................................................. 5
- Contact Information ................................................................. 5
- Login ................................................................. 6
- Security Statement ................................................................. 6
- System Check ................................................................. 6
- Browser Set Up ................................................................. 7
- Import from Previous Year ..................................................... 7
- Navigation ................................................................. 8

### Home
- Yearbook Deadlines ................................................................. 9
- Yearbook Checklist ................................................................. 9
- What to Do Now ................................................................. 10
- My Tasks ................................................................. 10
- My Profile ................................................................. 10
- Student Frequency Report ..................................................... 11
- Video Tutorials & FAQs ....................................................... 11
- Traffic Report ................................................................. 11
- Yearbook Page Status Report .................................................. 11
- Shortcuts ................................................................. 12
  - Manage Users ................................................................. 12
  - Creating User ID's ........................................................... 12
  - Assigning Site Features & Page Access ................................ 13
  - Usage History ................................................................. 13
- Sales Tracking & Resources ..................................................... 14
  - Sales Tracker ................................................................. 14
  - Smart Selling Resources .................................................. 15
  - Sales Materials ................................................................. 15
- Help ................................................................. 16
  - Reference Documents ...................................................... 16
  - Contact Us ................................................................. 16
  - FAQs & Video Tutorials .................................................... 16

### Book Settings
- Color & Deadline Assignment .................................................. 17
  - Select Spot Color (Volumes ONLY) ..................................... 18
- Portraits ................................................................. 19
- Borders & Backgrounds .......................................................... 19
- Fonts ................................................................. 20
- Styles ................................................................. 21
- Custom Dictionary .............................................................. 24
- Site Preferences .............................................................. 24

---
# Table of Contents

## Book Creation: Plan
- View Book ................................................................. 25
- Cover & Endsheets WebEase ........................................ 26
- Proof Covers ............................................................... 27
- Cover & Endsheets Volumes ......................................... 28
- Ladder ................................................................. 29
- Submit to Lifetouch .................................................... 30
- Approve a Page .......................................................... 30
- Master Pages ............................................................. 31
- View Proofs ............................................................... 32
- Yearbook Preview ....................................................... 32
- Organize Pages: Swap/Copy/Move .............................. 33

## Book Creation: Libraries
- Image Management ..................................................... 35
- Upload Images ............................................................ 36
- Image Libraries ......................................................... 38
  - Create New Folder .................................................. 40
  - Rename Folder ........................................................ 40
  - Delete Folder .......................................................... 40
  - Image Usage ............................................................ 41
  - Search ................................................................. 41
- Portrait Library .......................................................... 42
  - Export Portraits ...................................................... 44
  - Add Sort ............................................................... 44
  - Search Portraits ...................................................... 44
  - Re-sort ................................................................. 45
  - Add Name ............................................................. 45
- Borders/Backgrounds/Clip Art/Folios ............................ 45
- Template Library ........................................................ 46
- Create Custom Templates ........................................... 46
- Index Library ............................................................. 47
- Create Index ............................................................. 48

## Book Creation: Build
- Page Icons & Control Palettes .................................... 49
- Action Icons .............................................................. 49
- Menus: Page/Element/View ........................................ 49
- Apply Template ........................................................ 52
- Image ................................................................. 54
- Adding Images to Page .............................................. 54
TABLE OF CONTENTS

BOOK CREATION: BUILD

Image Details ........................................................................................................55
Applying Backgrounds, Borders & Clip Art ..........................................................56
Text .......................................................................................................................56
Font .....................................................................................................................57
Color & Effects .....................................................................................................58
Spacing & Alignment .............................................................................................58
Special Characters ...............................................................................................59
Add Elements .......................................................................................................59
Properties ............................................................................................................60
Image Effects .........................................................................................................60
Shape ....................................................................................................................60
Fill .........................................................................................................................61
Border ...................................................................................................................61
Drop Shadow .........................................................................................................61
Size & Position .....................................................................................................61
Keyboard Shortcuts ...............................................................................................62

RESOURCES

Troubleshooting .....................................................................................................63
Glossary ................................................................................................................70

INDEX ....................................................................................................................74

* Information in this document is subject to change without notice. Complying with all applicable copyright laws is the responsibility of the user. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Lifetouch National School Studios Inc. © 2002-2008. All rights reserved. Adobe is a registered trademark of Adobe Systems Incorporated in the United States.
Welcome to Lifetouch Yearbooks online!
This guide was designed for both WebEase and Volumes users. As you read through the guide, you will see specific features identified that may be only available for the WebEase or the Volumes program.

**SYSTEM REQUIREMENTS**

<table>
<thead>
<tr>
<th>PC</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating System</strong></td>
<td><strong>Operating System</strong></td>
</tr>
<tr>
<td>• Microsoft Windows 2000</td>
<td>• Apple Mac OS 10.4 (Tiger) - 10.5 (Leopard)</td>
</tr>
<tr>
<td>• Windows XP</td>
<td></td>
</tr>
<tr>
<td>• Windows Vista</td>
<td></td>
</tr>
<tr>
<td><strong>Hardware</strong></td>
<td><strong>Hardware</strong></td>
</tr>
<tr>
<td>• Windows Compatible with Pentium 4 with 1.6 GHz or higher processor (2.5 recommended)</td>
<td>• Mac with PowerPC G3 or higher processor</td>
</tr>
<tr>
<td>• 1 GB of RAM or higher (2 GB recommended)</td>
<td>• 1 GB of RAM or higher</td>
</tr>
<tr>
<td>• Hard disk with minimum 1 GB of free space recommended</td>
<td>• Hard disk with minimum 1 GB of free space recommended</td>
</tr>
<tr>
<td>• SVGA monitor with 1024 x 768 resolution or higher required (1280 x 1024 resolution recommended)</td>
<td>• SVGA monitor with 1024 x 768 resolution or higher required (1280 x 1024 resolution recommended)</td>
</tr>
<tr>
<td>• Mouse or compatible pointing device</td>
<td>• Mouse or compatible pointing device</td>
</tr>
<tr>
<td>• CD-ROM drive</td>
<td>• CD-ROM drive</td>
</tr>
<tr>
<td><strong>Browsers</strong></td>
<td><strong>Browsers</strong></td>
</tr>
<tr>
<td>• Internet Explorer v6.0 (Windows 2000 Service Pack 2 and above only)</td>
<td>• Safari v3.0 – 3.1</td>
</tr>
<tr>
<td>• Internet Explorer v7.0 (Windows XP and Windows Vista)</td>
<td>• Firefox v3.0</td>
</tr>
<tr>
<td>• Firefox v3.0</td>
<td></td>
</tr>
<tr>
<td><strong>Additional Software</strong></td>
<td><strong>Additional Software</strong></td>
</tr>
<tr>
<td>• Adobe Macromedia Flash v9.0</td>
<td>• Adobe Macromedia Flash v9.0</td>
</tr>
<tr>
<td>• Adobe Acrobat Reader v6.0 (Windows 2000 Service Pack 2 and above only) – v8.0</td>
<td>• Adobe Acrobat Reader v6.0 (Windows 2000 Service Pack 2 and above only) – v8.0</td>
</tr>
<tr>
<td><strong>Internet Access</strong></td>
<td><strong>Internet Access</strong></td>
</tr>
<tr>
<td>• High-speed Internet access (minimum connection speed of 150kb/s)</td>
<td>• High-speed Internet access (minimum connection speed of 150kb/s)</td>
</tr>
<tr>
<td>• Access to Internet e-mail</td>
<td>• Access to Internet e-mail</td>
</tr>
<tr>
<td>• Disabled pop-up blocker</td>
<td>• Disabled pop-up blocker</td>
</tr>
</tbody>
</table>

**CONTACT INFORMATION**

**WebEase Kansas City Customer Care**
10800 Ambassador Drive
Kansas City, MO. 64153
Phone: 1-800-736-4761
Fax: 1-816-880-5580
Email: Kccustomercare@lifetouch.com
Web: http://onlineyearbooks.lifetouch.com

**WebEase Loves Park Customer Care**
5126 Forest Hills Court
Loves Park, IL. 61111
Phone: 1-800-736-3035
Fax: 1-815-636-5360
E-mail: Lpcustomercare@lifetouch.com
Web: http://onlineyearbooks.lifetouch.com

**Volumes Customer Care**
10800 Ambassador Drive
Kansas City, MO. 64153
Phone: 1.800.736.4762
Fax: 1.816.880.5437
E-mail: Volumes@lifetouch.com
Web: http://onlineyearbooks.lifetouch.com
GETTING STARTED

LOGIN

Step 1: Login
Once enrolled, you will receive two emails that provide your job number, user name and password.
With that information, you can go to http://onlineyearbooks.lifetouch.com to access the Online Yearbooks website.

When you login for the first time, you will be asked to go through a few initial set-up steps, then you will be directed to the Home page.

SECURITY STATEMENT

You will be asked to accept the security information on the use of the Online Yearbooks website and the Internet.

SYSTEM CHECK

Step 2: Run the Online System Check
The system check will make sure your computer’s software and performance are compatible with our website.

System requirements that your computer already meets will be marked with a green check mark.
Requirements that are NOT yet met will be marked with a red “X.” You can learn how to fix the problem by clicking “Read”. If you need help, you can contact your school/district technology representative, or Lifetouch Customer Care.
Step 3: Set Up Your Web Browser

This site uses some of the newest features on the web, and your browser settings can have a big impact on your experience using this site. Follow the three steps listed on the Browser Setup page to optimize your experience.

Step 4: Import Items From Previous Year

If your school used our website last year and created custom styles or templates, you might save time by importing those settings to use in this year’s book. Advisers will be directed to the Import screen after the initial sign-in to complete this step.

If you did not use our website last year, or didn’t create custom styles or templates last year, there will be nothing to import.
Before you begin, it may help to familiarize yourself with this website. This site has three main sections, described below. You can also watch our online video tutorials, which will walk you through all the basic features and steps.

**A Home:** The Home Page gives you an overview of your progress, and the tools to help you easily complete your yearbook project. Features include:
- Manage Users
- Sales Tracking & Resources
- Help
- Contract Details
- Yearbook Deadlines
- Yearbook Checklist
- Traffic Report
- Yearbook Page Status Report
- View My Pages
- What to Do Now
- My Tasks
- My Profile
- Yearbook Shortcut Links

**B Book Settings:** Your Book Settings help you make decisions and maintain consistency throughout your book. You will define settings for:
- Color & Deadline Assignment
- Portrait Preference
- Borders & Backgrounds
- Fonts
- Styles
- Dictionary
- Site Preference

**C Book Creation:** You will plan content, organize libraries and build pages in Book Creation.

**FYI: CUSTOMIZE YOUR SITE**

You can customize your website to display only the features that you or your staff members will use. See Home > Manage Users or Book Settings > Site Preferences.
Home gives an overview of your progress, plus tools to help you manage your yearbook project.

Yearbook Deadlines help you track:
- Deadline date for cover, endsheets, pages and final quantity
- Submission Status
- Date completed
- Days remaining before deadline

The Yearbook Checklist guides you through the steps that need to be done before your final yearbook submission date.
WHAT TO DO NOW

What to Do Now alerts you of the time-sensitive tasks that should have top priority. The following are examples:
- Approaching deadlines
- Submission of certain sections of the book
- Available proofs uploaded by Lifetouch

MY TASKS

You control the content that appears in the My Tasks. You can create a task for yourself or a task assignment for another individual.

MY PROFILE

My Profile is a summary of the details that are unique to you, including:
- Name and user name
- Password
- Email
- Site and page access
- Usage history

This is also the area where you can change user name, password or email.
The **Student Frequency Report** helps you manage the number of times a student appears in your book. This calculation is based off of the entries that are submitted for the Index. See page 47 for details.

**Video Tutorials & FAQs** are tools you can use to find information on a variety of topics.

The **Traffic Report** gives you an indication of the response times you can expect for uploading photos and creating PDF proofs.

The **Yearbook Page Status Report** gives the status of your yearbook pages in a visual bar chart. You can use “View My Pages” to virtually flip through your saved pages. (Keep in mind that these previews are updated nightly, and will not reflect the changes you make until the next day.)
**SHORTCUTS**

**Shortcuts** give you quick access to:
- Ladder Diagram
- Image Library
- Image Upload
- Portrait Library
- Build Pages

**MANAGE USERS**

The **Manage Users** section is where advisers can give other people permission to work on the yearbook.

**CREATING USER ID’S**

Advisers can **Add Users** by providing a unique user name, email address, and other information.
ASSIGNING SITE FEATURES & PAGE ACCESS
Advisers can assign site features to staff members by selecting or deselecting the Site Features options. Advisers can also allow or restrict users' access to specific pages.

USAGE HISTORY
Usage History shows the frequency and duration of users' activity within a specific month. History for each month will be available as long as the account is active.
The Sales Tracking & Resources tab allows you to access:

- Sales Tracker
- Smart Selling Resources
- Sales Materials

Sales Tracker is a tool for you to track book sales, manage your personalized covers, and other details related to your final book order. Once portraits have been uploaded all student names will be available on Sales Tracker. If sales have already been entered, you will need to review the list for duplicates.

Sales Tracker is organized into three sections:

- **Student Information** allows you to sort the name list by Grade, Homeroom, or Teacher ID from the drop-down menus.

- **Order Information** indicates the following:
  - Order Received: When an order is placed and it is paid in full, this column will say Yes. If an order is not placed or if there is a balance due, this column will say no.
  - This area also includes an overview of the quantities ordered by each student for Standard Yearbooks and any enhancements you are contracted for (e.g. Zoom, autograph inserts & pens).

- **Payment Details** indicates the Total Due, if a Discount applies, the total amount of the Payments Received and the Balance Due.

**HOW TO: GET STARTED USING SALES TRACKER**

1. Set the prices of your book, the available options, and early payment discounts.
2. Check the list for duplicates that might appear if names were entered before the portraits were uploaded. If duplicates appear, be sure to only complete order information for one of the records.
3. Start recording orders; which will then automatically be included in Total Yearbook Orders and Total Payments to date.
SALES TRACKING & RESOURCES

**HOW TO: ADD, VIEW OR EDIT STUDENT ORDER DETAILS**
- To add a new student that wasn’t included in the original list, click “Add New Student.”
- To find a specific student, click “Search.”
- To change the details of a student’s order, click “Edit.”

**HOW TO: CUSTOMIZE YOUR LIST**
- To re-arrange the order of the list, click the column heading to select the attribute you want the list to sort by. You can click the column header again to switch between ascending (A-Z) or descending (Z-A).
- To show only certain information, instead of ALL of the information, select an option in the drop-down menu and click “Show”.

**HOW TO: SUBMIT YOUR FINAL LIST TO LIFETOUCH**
1. Select “Submit Final List” under Submission Status.
2. Review the Order Summary that will appear next.
3. Indicate if you would like your books shipped in alphabetical order by the entire school.
4. Submit your order to Lifetouch by clicking “Submit.”

**SMART SELLING RESOURCES**
Smart Selling Resources include email reminders, announcements, advertising and other materials to help you promote your yearbook.

**SALES MATERIALS**
Sales Materials can be ordered from Lifetouch or downloaded in PDF format.
Help gives you access to FAQ’s, video tutorials, and more.

REFERENCE DOCUMENTS

CONTACT US
Contact Us makes it easy to send a message to Lifetouch.

FAQ & VIDEO TUTORIAL
FAQ’s and Video Tutorials cover a wide variety of helpful topics.
**Book Settings** lets you select default preferences to maintain consistency and save time. You can pick defaults for portraits, fonts, styles, backgrounds and more. Book Settings is also where your Color & Deadline Assignment page is located.

**Color & Deadline Assignment** is where you can pick which pages will be in color, if your contract includes color pages. You must assign the color before you can start creating pages.

**HOW TO: ASSIGN COLOR PAGES**
1. **Review your contract details** to find out how many color pages you can have.
2. **Pick your color pages** by selecting the check boxes for a flat (8 pages) or the entire signature (16 pages).
3. **Save your color assignments** by clicking “Save.”

**FYI: COLOR ASSIGNMENT DETAILS**
- **You can make changes** to your color assignments up until you start submitting pages. After you start submitting pages, you can only make color assignment changes to signatures that don’t contain any submitted pages.
- **You cannot make changes** to the color assignment of a signature after one or more of its pages have been submitted.

**FYI: ASSIGN DEADLINES**
- **WebEase users must assign deadlines** to each signature (they will either be in the 1st or 2nd deadline) before you begin creating pages.
Spot Color
If your contract includes spot colors, you must select and assign your spot colors before you can start creating pages.

**HOW TO: SELECT SPOT COLORS**
1. Begin the process by clicking “Select Spot Color.”
2. Add a Spot Color by clicking “Add Spot Color,” which will open a new window.
3. Choose your color(s), then click “Add Color.”
4. Click “Close” to return to the Assign Color window.

**HOW TO: ASSIGN SPOT COLORS**
1. Select a flat or signature you want to have spot color(s).
2. Select 1 or 2 spot colors from the drop-down menu.
3. Double click on Select Spot Color box. Highlight the color to use and click Select Color.
4. Repeat steps 1-3 according to the details of your contract.
5. Click “Save” to complete the process.
Your **Portraits** settings will determine how people’s names will be formatted on your portrait pages. This is also where you would select your preference for individuals with no portraits.

**HOW TO:**

**SELECT PORTRAIT DETAILS**

1. **Pick your preferred Name Display** by selecting “First Last” or “Last, First.”
2. **Choose a font** for the names. If you want to use the bold version of that font, click “B.”
3. **Select your preferred “No Photo” artwork** that will be displayed for students who don’t have a photo.
4. **Click “Save”** to complete the process.

Setting defaults for page **Borders and Backgrounds** will help you save time and increase consistency throughout your book. The Volumes yearbook program does not include borders.

Just like your other default selections, the border and background you pick here will automatically be included on every page, but you can make changes when you are creating a page in Page Creation>Build.

**HOW TO:**

**SELECT BORDERS & BACKGROUND**

1. **Begin the process** by selecting “Borders & Backgrounds.”
2. **Make a selection** by clicking the images in the scrolling panel on the left.
3. **Click “Save”** when you have decided which option you like best.
Your Fonts settings will establish the set of font options available throughout your book.

**HOW TO: SELECT YOUR FONTS**

1. Review the existing yearbook fonts already available for use by viewing the “Fonts Available in Yearbook” window.
2. Select additional fonts by clicking “Add Additional Fonts.”
3. Highlight the fonts (see FYI below) you want, and click “Add Fonts.”
4. Define your default fonts for headlines, sub-headlines, body copy and captions using the drop-down menu, then click “Save.”

**FYI: FONT SELECTIONS**

You can select multiple fonts at one time by holding down the Control button on your keyboard (or Command for Mac users) while scrolling down the list and clicking on the font(s) you want. **Avoid slow site performance** by only adding the fonts you know you will use. Using more than 10 fonts can slow down the process to create pages. **The default fonts you select** here will determine the fonts that will be automatically used when you first start working on a page, but you can manually change the fonts as you create pages.
A style is a set of attributes for a specific type of text. It includes things like font, size, color, leading, kerning, tracking, alignment and tint.

There are two types of styles:

1. **Styles provided by Lifetouch** are automatically included in all Lifetouch templates and flow into the template when selected.
2. **Custom Styles** are styles that you create yourself. You can either modify one of the styles and save it with a new name, or you can create a style from scratch.

**HOW TO: SAVE TIME WHEN CREATING STYLES**

- If you have selected a font that will be used frequently for specific types of text, you should **pick your default fonts in the Fonts tab first**, then go to the Styles tab to view and customize styles.
- After your styles are selected, you might find it helpful to **print out the style sheet** and distribute copies to your staff.

**HOW TO: VIEW AND EDIT STYLES PROVIDED BY LIFETOUCH**

1. Review the list of styles provided by Lifetouch and click the one you want to view or edit.
2. **View or change the style attributes** on the resulting screen.
3. **Complete the process** by clicking “Save as Custom Style.” Your edited style will be saved and updated in the Styles Provided by Lifetouch list.
HOW TO:
CREATE A CUSTOM STYLE
1. Name the new style by entering it in the name field.
2. Pick the attributes you want the style to have.
3. Complete the process by clicking “Save as Custom Style.” Your new style will be saved and added to the Custom Styles list.

FYI: TYPOGRAPHY RECOMMENDATIONS
• Use styles consistently. For example, all headlines should use the same style, and the style used for headlines shouldn’t be used for anything else.
• Don’t use too many different fonts. Often the most appealing and easy-to-read publications only use three or four fonts.
• Make sure your text is readable against your background color.

FYI: HEADLINES
• Headlines should summarize the story and entice the readers. A primary headline should grab the reader’s attention, and a secondary headline should summarize the story.
• The headline style should match the tone of the document.
• Headline fonts should be consistent throughout the book.
• Headlines often look best when you use a sans-serif or decorative font.
• Create visual distinction. If your headline font is the same as your body copy font, make sure the headline is larger and/or bold to set it apart from the body copy.
• Try not to center your headlines. Use ragged-right or fully justified text.
FYI: BODY COPY
• Capitalization and styles should be consistent throughout the body copy.
• There should only be one major copy block per page.
• Use sidebars or secondary stories to add visual interest to the rest of the page.
• Include captions with all photos. Captions should be no more than two to three sentences, and often look best in 9-point type.

FYI: ATTRIBUTE DEFINITIONS
• Style Name is the name you give a Custom Style or the pre-defined name for a Style Provided by Lifetouch.
• Font Name displays the name of the font.
• Font Size displays the size of the font in points.
• Font Style lists the available styles for a font, such as bold, italic, underline or drop cap. Drop cap inserts a larger letter as the first letter of a paragraph. The size of the drop cap is determined by the number of lines you want it to occupy. (Not all styles are available for all fonts.)
• Color determines the color of the text. To decide which color you want, see the colors in the Color Sampler in your kit.
• Leading lets you increase or decrease the space between lines.
• Kerning adjusts the space between pairs of letters to create a visually pleasant configuration. Kerning is strictly proportional, so the space gets bigger or smaller relative to the character’s point size. Kerning is most effective when used with 18-point text or larger.
• Tracking determines the amount of space between letters and words.
• Alignment determines placement of the text. You can: Align Left, Align Center, Align Right, Justify and Full Justify.
• Tint is the percentage of color the text will be printed in. The default is 100% (darkest) but you can make the color lighter by decreasing the percentage. Keep in mind that text on a background should be at least 60% to be readable.

Use the space below to write down the styles you would like to use in your book. This may be helpful when building pages.

__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
A Custom Dictionary can make the spell checking process more efficient.

Many yearbooks contain words with unique spellings, like mascot names or school slang. Also, most first and last names aren't typically included in a standard dictionary.

After importing names and unique words, they will no longer be flagged as misspelled when spell checks are run, so you can find the real errors a lot faster.

Once your Portraits have been uploaded and you have reviewed and made corrections to the student names in the Portrait Library, you can upload those names to the Custom Dictionary from the Portrait Library area. Portrait Names will have a green background behind them in the dictionary. Those names may not be deleted from the Custom Dictionary.

**HOW TO: IMPORT YOUR NAME LIST**

1. Create a new spreadsheet (you can use any spreadsheet application you choose) and use the top row to label the columns. The first column must be "LASTNAME", and the second column must be "FIRSTNAME."
2. Enter all the names under the appropriate columns.
3. Save the file in CSV format by selecting "Save As" in the File menu of your spreadsheet, then pick "Save as Type: CSV (Comma Delimited) (*.csv)."
4. Import the file by clicking "Browse" on the Custom Dictionary page. Locate your file, then click "Import."

Site Preferences is where you define how you want to view and create your pages, and other aspects of how you'd like to use the site.

- Indicate if you would like to view and build pages in single or double page spreads.
- Indicate your preferred Units of Measure: Picas or Inches
- Indicate if you would like to show page trim marks: Yes or No
- Set up the website as a favorite or as a shortcut on your desktop.
- Under Site Features, customize your site to only show areas that will be used during the yearbook process. This area is viewable by Advisers only. WebEase will have Index and Master Pages turned off by default.
The Plan tab includes two main areas:

A View Book
B Organize Pages

The **View Book** area is where you can:

- Plan the details of your cover and endsheets
- Create and edit your Ladder Diagram and access the Portrait Page Calculator
- Create Master Pages
- View proofs
- Preview the whole yearbook
- Review, submit and approve (if applicable) pages to Lifetouch
WebEase Cover & Endsheets

If using the WebEase program, the cover and endsheet wizards will walk you through the options you have for the cover and endsheets of your book. To order Cover Keepers or request Creative Services, click the Additional Features link.

FYI: WEBEASE COVERS AND OPTIONS

- Your Publication Agreement determines your cover options. The "$" symbol means that the option has an additional charge.
- Three proof options are available for ProDesign, Special Design, Original Design, and Custom Montage. Your options are: PDF, hard copy black-and-white, or hard copy color cover.
- You must mail your custom artwork to Lifetouch to satisfy your cover deadline.
- Original Design Covers must be selected online and the artwork mailed to Lifetouch. More instructions are provided in your Covers Book.

FYI: WEBEASE ENDSHEETS

- You must complete the Endsheet Wizard if your book includes a hard cover.
- You can select designs for each endsheet category. You can either select different designs for the font and back of your book, or you can select the same design for both.
- You can’t change your endsheets after they have been submitted, but you can view them online.
**FYI: REVIEW COVERS BOOK**

You can refer to your Covers Book (included in your kit) to see examples and learn about various covers and enhancement options, such as:

- Personalized covers
- Original covers
- Foil imprinting
- Spine printing
- Endsheets

**HOW TO: APPROVE A PDF PROOF**

1. **Review the PDF proofs** of your cover and endsheets within 48 hours of the posting.
2. **Make note of any desired changes** in Creative Services area and submit. Keep in mind that extensive revisions might cost more. You should talk with your Lifetouch Yearbook Representative if you have revisions or questions.
   - Select “Approve” if you have no additional changes on your cover and endsheets. Otherwise, describe your desired changes and submit them back to Lifetouch.
COVER & ENDSHEETS

Volumes Covers & Endsheets
If using the Volumes program the Cover & Endsheets control palette lets you
• Print out the Volumes Cover and Endsheet Forms.
• Review uploaded cover proofs for those who requested a PDF proof.
• Submit final Creative Services requests to Lifetouch.

FYI: CREATING & SUBMITTING COVER ARTWORK
• Designing Covers: Covers often look best when designed with vivid colors and high contrast. If the cover art is supposed to fill the entire cover (full bleed), make sure there is enough background surrounding the design so no white is showing around the edges. This is very important for large photos and backgrounds that use patterns or gradient blends.
• Photo Collages: If your cover includes photo collages, don’t build up layers of overlapping photos.
• Original Artwork: Avoid using light crayon or colored pencil drawings for original artwork, because they don’t scan well and much of the image might be lost. Avoid feathered or gradient artwork. Submit computer-generated line art whenever possible.
• Software: When the cover design is created in software programs like Adobe Illustrator or Adobe InDesign, be sure to submit the artwork with all links (clip art, photos, etc.) and fonts used to build the cover design.
• Resolution: The resolution must be at least 600 dpi. Always submit a printout of the electronic cover design.

Once you submit your cover and endsheets to Lifetouch, we will create and upload the proofs to your account.
A thumbnail-sized image of your cover and endsheets (if applicable) will be displayed.
Clicking on the proof icon will display a PDF version of your cover and endsheet proof. You can view, save, print or email the PDF proof. See page 27 on how to handle proofs.
The Ladder helps you get an overview of your book. You can view pages in either “Diagram” or “List” view.

The “Diagram View” gives you a visual representation of each page spread, along with the page details.

The “List View” shows your pages in a sequential list.

You can edit your page information quickly in the “Edit All” view. You can also sort your pages by their current status to see the progress of each page. You can view up to 100 pages at a time. When using the “Search” or “Show All” features the site will only search the pages on that are displayed on your Ladder at that time.

In both views, the color of the thumbnail box indicates the page status:
- **Red**: Not Started
- **Yellow**: In Progress
- **Orange**: Submitted to Adviser
- **Green**: Submitted to Lifetouch
- **Blue**: Needs Adviser Approval

### HOW TO: SELECT TEMPLATES IN THE LADDER

1. Select the “Ladder” control palette.
2. Select the page(s) you want to work on by entering a page number or a range of pages.
3. Specify the Page Details by clicking “Edit Details” and providing a description of the page, page type, and more.
4. Select a template by scrolling down the template list using the up and down arrows. Once selected, a thumbnail of the template will appear. Repeat this step to choose another template.
5. Assign a Master Page style, if applicable.
6. Click “Save Changes” to complete the process.
When you are ready to submit a page to Lifetouch, you must review your PDF proof very carefully. Once you have reviewed your PDF proof, click “Submit to Lifetouch.” If you would like additional changes made to your page that you are not able to complete yourself, indicate your instructions in the “Request Creative Services” area under the Page Actions drop-down.

**FYI: PAGES WITH THE SAME SORT VALUE**

All pages that include portraits from the exact same sort must be submitted at one time. (e.g., if the portraits from Mrs. Johnson’s 6th Grade are featured on pages 6 and 7, both pages must be submitted at the same time).

If you requested Creative Services for any pages, you will receive a proof of each page before it is printed. An email will be sent to the yearbook adviser when Lifetouch has uploaded the proof for review. Locate the proof (a PDF icon) on the Ladder. Click the PDF icon to open the proof. You must approve the changes you requested within the allotted time frame indicated in your email, or it will be auto-approved by Lifetouch.
Use Master Pages to create a consistent page design either for your entire book, or by section. You can include elements like folio art, text, sidebars, and more.

**HOW TO:**
**CREATE A MASTER PAGE**
1. Name your Master Page by selecting “Edit Details” in the Master Page control palette.
2. Double click on the thumbnail to activate the page creation workspace.
3. Create the Master Page using the various tools and page elements available in the Control Palettes.
4. Select “Save” to complete the process.

**FYI: MASTER PAGES**
- **Creating Master Pages:** You can create up to 16 Master Page spreads. Master pages can also be built and saved in the Build tab.
- **Applying Master Pages:** After you have created your Master Pages, you can apply them to the pages in the Ladder. When a Master Page is applied to a page, the layout inherits the master page elements.
- **Locking and unlocking Master Pages:** You can unlock master page elements when building pages by selecting the element and then selecting “Lock/Unlock” from the Element Actions menu.
- **Viewing Master Page elements:** When a layout is open in the Build tab, Master elements can be identified by selecting “Highlight > Master Page Elements” under Page Actions.
- **Disabling Master Pages:** If you don’t want to use Master Pages in your yearbook, this feature can be disabled in Site Preferences under the Book Settings section.

**FYI: FOLIO TEXT/GRAPHICS**
- **Contrast:** Make sure the folio text/graphics on the Master Pages don’t blend in with the page backgrounds.
- **Dark colors:** If your school’s folio text/graphic is a dark color, it’s not going to be visible against a dark background. To fix the problem, you can either make a local change to the Master Page and change the folio text/graphic to white or another light color, or you can create separate Master Pages—one with black text/artwork and one with white text/artwork.
To **View Proofs**, you can enter the range of pages you want, and they will all be included in the PDF proof. After the PDF is generated, you can view, save or print it.

**YEARBOOK PREVIEW**

The **Yearbook Preview** control palette lets you page through your book two pages at a time or as a slide show. You can click “Next” to preview each page consecutively. (Keep in mind that these previews are updated nightly, and will not reflect the changes you make until the next day.)
Clicking on the **Organize Pages** icon lets you:
- **Swap** the location of two pages.
- **Copy** the text and layout of one page onto a new page.
- **Move** the elements from one page to another.

**FYI: Organize Pages**
- You can use this feature for pages that are not started (red border), or pages in progress (yellow border).
- Before your action occurs, you will see a pop-up message to confirm what is about to happen.
- If you change your mind about the change you just made, you can't click the "undo" icon, but you can make the same action in the reverse direction.

**Swap**

**Swap** lets you exchange the location of two pages.
- **Double-page mode** must be used if a page spread includes cross-gutter elements.
- You can't swap pages after you flow the portraits or index.

**Copy**

**Copy** lets you create a duplicate of an existing page. You can copy in either single-page or double-page mode.
- In **single-page mode**, if you copy an odd page to an even page, the elements will maintain their existing position on the page.
- **Double-page mode** must be used if a page spread includes cross-gutter elements.

**Move**

The **Move** feature enables you to change the location of a double-page spread within a 10-page range.
- Moving a page will cause the pages after it to shift.
- You can't move pages after you flow the portraits or index.
The Libraries tab helps you keep your photos, graphics, templates and index names organized. The three icons within this tab include:

A Image Management
B Template Libraries
C Index Editor

Image Management helps you organize your photos and other graphics into three categories:

- **Image Library** contains all of your candid and activity photos.
- **Portrait Library** is where the student and staff portraits are uploaded from Lifetouch.
- **Borders/Backgrounds/Clip Art** includes all of the additional graphics that bring visual interest to your book.
There are two ways to upload images into the site:

**You can upload your own images**, which is usually the fastest and easiest way to start working with your own photos.

**You can mail a CD or prints** to Lifetouch. We will upload off the CD, or scan your prints for you.

### UPLOADING YOUR OWN IMAGES

The upload images function enables you to load your own digital files directly into the site. You can upload 50 images at a time. We recommend that you only upload images that you intend to use, or delete those images that you do not plan on using. Once uploaded, the images can be included in the library you choose. You may also drag and drop images into new folders.

### HOW TO: UPLOAD IMAGES

1. Click the “Upload” button to get started.
2. Indicate which folder you would like your images uploaded into.
3. Browse and select the images you want to upload. Your images will be placed into a list, called a queue, until you are ready to upload them. You can select multiple images by holding down Shift or Ctrl while clicking on the files. Choose up to 50 images to place into your queue at one time.
4. Click “Upload Images” to complete the process. If you need to upload more images right away, click “Browse” and select additional photos.

### FYI: CANDID IMAGE CAPACITY

The total number of candid images allowed in your image library is a calculation based on the total number of pages in your book. Multiply the total number of pages by 15 to achieve the maximum number of candid images allowed. (e.g., a 96-page book is allowed 1440 images (15 images x 96 pages).}
**FYI: PREPARING IMAGES FOR UPLOAD**

- **Make sure your images are high resolution.** Only upload high-resolution images, but make sure they aren’t more than 10MB per image. You won’t need to upload low-resolution images, because the site will create them for you.
- **Save your files in the most appropriate format.** Photos work best in .tif or .jpg format, and line art should be in .eps format. For .jpg images, use the highest quality and lowest compression settings available.
- **Use the camera zoom carefully.** Use only the optical zoom on your digital camera (instead of the digital zoom).
- **Name your images with “keyword” information** to help you sort them once they are uploaded. Our system will rename the uploaded images using the sequential job number and “-CU”, which stands for “Customer Upload.” Your original file name will be captured in the keyword search area in the Image Library.

**FYI: TIPS FOR SUBMITTING PRINTS**

- **Review your images carefully.** Make sure none of your images have poor quality (e.g., poor color, fuzzy or distorted images), and check for duplicates. You should only send the prints you intend to use in the book. This saves needless scanning and allows your images to be uploaded faster.
- **Create consistent Image Library names.** For example, if your current library is titled Ninth Grade, write “Ninth Grade” on all of your items. Do not use variations of the library name (e.g. 9th, Grade 9, Freshmen).
- **Don’t use paper clips or manila envelopes with metal clasps.** The clasps can scratch photos.
- **Send items on a regular basis** as they become available to you. You don’t have to wait until you have a large quantity of items before you mail them to Lifetouch. Frequent submissions allow for faster uploads, which gives you access to images sooner.

**MAILING IMAGES TO LIFETOUCH**

You have the option to mail your activity photos and clip art (prints or on CD) to Lifetouch, where they will be professionally scanned and placed in your Image Libraries. The Photo Materials Envelope has the materials you need. To order additional materials, contact your Lifetouch yearbook representative or e-mail yearbook_supplies@lifetouch.com.

**HOW TO: MAIL CDS AND PRINTS TO LIFETOUCH**

1. **Sort all images into categories** according to how you’d like the images to be loaded into your online libraries (e.g., sports, candid photos, school events).
2. **Attach Photo I.D. Stickers to each printed image** to make sure images can be identified by job number.
3. **Label the images with the library name.** Prints can be placed into Image Library Envelopes filled out with your job number, school name, total number of photos, and the library name. CDs should be labeled with the library name.
4. **Mail the shipment to Lifetouch,** where your images will be uploaded within two business days of receipt. You will receive an email confirming that we uploaded your images.
**Image Libraries** help you keep your photos organized. In the Image Library control palette you can:
- **Create as many Image Libraries as you like.** You can be as broad or specific as you want to be.
- **Create sub-folders** under main folders, to keep related groups of images together. You need a top level folder before you can create sub-folders.
- **Access the montage page designs** that you may have sent to the plant to be uploaded.

**HOW TO: VIEW PHOTOS**
1. Click on an Image Library name to view image details.
2. Browse the library to find an image. Below the image, you'll see the name of the image and the page number(s) it has been placed on, if any.

This zoom bar will allow you to enlarge the images in your library screen.
The image detail screen includes:

- **Image Name**: The name created by our system when the image is uploaded.
- **Submitted By**: The name of the person who uploaded the image.
- **Appears on Page**: If the image appears on a page, it will be indicated here.
- **Maximum Print Size**: Displays the largest size the image can be displayed in before the quality of the image is impacted.
- **Photographer**: Enter the photographer’s name here, in case you need to contact that person with questions about the photo.
- **Keyword**: Enter the words you would use to search for this photo when creating your pages.
- **Rating**: Indicate how much you like the image, or how strongly you feel about the photo being used in the book, by giving the photo between one and five stars.
- **Name for Index**: List the names of the people in photos so they will appear in the Index. Each time the image is placed on a page, the names in this field will be flagged for the Index.
- **Image Library**: Lets you move an image from its current Image Library to a different Image Library.
- **At the bottom of the Image Details screen you will see an Image Well. You can navigate to a different image in that sort by clicking on the thumbnail of that image in the Image Well.**

If you add the names of the students in each picture, when that picture is used on a page the names will automatically be transferred to the Index Editor.

**HOW TO: ENTER NAMES FOR INDEX**

1. Double click on Image Name and the Image Details screen will open.
2. Click on Enter Names in Name for Index line.
3. The Enter Names to Index screen will open. Type in the names of all people in the selected image.
4. Click Save.
5. Click Save Changes in Image Detail screen.
**New Image Library folders and sub-folders** are easy to create. Start by clicking “New Folder,” select a location. If you want your folder to be a main folder, select Top Level. If you want it to be a sub-folder, select the Library Name you want it under. Enter a name and click Create.

Folders and sub-folders can be renamed at any time. Just click “Rename Folder,” select the folder you want to rename from the drop-down menu, and enter a new name for it. Click Rename.

Folders can be deleted by clicking “Delete Folder” and selecting the folder you would like to delete. Library folders can only be deleted if they are empty. Click Delete.
Image Usage gives you an overview of the images used on each page. Each library will also show the usage under each image.

You can search for an image in several ways:

- **Keywords**: Search with the keywords that you entered in the Image Detail screen.
- **Usage**: Search by “used” or “not used”.
- **Folder**: Search within a specific Image Library folder.
- **Rating**: Search by the rating (number of stars) entered in the Image Detail screen.
The **Portrait Library** contains all of your individual portrait images. The portraits will be placed into folders organized by teacher, grade or homeroom.

In this section, you can:
- **View** your portraits
- **Re-sort** your portraits
- **Flow and un-flow** your portraits

**FYI: PORTRAIT DETAILS**

When you click on a portrait name, you will see these details:
- **Image Name** is the name Lifetouch gives your photo when the image is uploaded.
- **First Name** is “first name” that was attached to the portrait on picture day.
- **Last Name** is the “last name” that was attached to the portrait on picture day.
- **Name will appear as** shows how the portrait name will appear in the book (“First Last” or “Last, First). You can change this in the Portraits area of the Book Settings section.
- **Title** is where you can enter the title of a faculty or staff member.
- **Faculty and Staff check box** indicates a faculty or staff member portrait. (This will tell the system to flow their portraits in front of the student portraits in the sort.)
- **Image Placement** lets you determine the order of appearance when there is more than one faculty or staff member in a sort.
- **Sort Value** lets you list a grade, homeroom or teacher ID for each portrait.
- **Appears on Page** indicates whether the image appears on any pages.
- **Uncheck the Use Portrait Image box for any images you do not want included in the yearbook.**

**FYI: OPTIONS FOR CHANGING PORTRAIT IMAGES**

If you need to change a portrait image, you can:
- **Replace an existing portrait with an image** from the Image Library.
- **Replace an existing portrait with “No Photo” artwork.**
- **Replace “No Photo” artwork with an image** from the Image Library.
- **Revert back to the original portrait** you had for a person, if you’ve already changed it once.
FYI: PORTRAIT LIBRARY DETAILS

Sort ID: The label associated with the sorts when they were uploaded by the plant or created by you.
Description: The information you add to help identify who is in the sort.
# of Images: The quantity of images in the sort.
Zoom: The tool that lets you enlarge or reduce the portrait image in the box. “No zoom” will keep the portrait as it is. The option you pick will affect all the images in the sort (see image at right).
Status: The details about the status of the sort, such as not enough pages to flow, or if the sort is already flown.
Action: Indicates the action that is available for the sort, such as flow, un-flow, or select pages.
Print: A quick way to load a printer-friendly version of the images according to your sort.
Delete: Lets you to delete the sort.
Export Portrait Names to Custom Dictionary: Allows you to send all portrait names to the Custom Dictionary so they don’t appear as misspelled words.

FYI: PORTRAIT FLOW GUIDELINES

Portraits can be flowed after you’ve assigned a sort value to enough portrait pages in the book. After you flow the portraits, you can make edits on the individual portrait pages, but not from within the Portrait Library. You must un-flow a sort if you need to make changes and you want your edits to appear in the Portrait Library.
The Export Portraits tool lets you download your Portrait images and names to a zip file. Just click “Export Portrait Information” to begin the download.

The Add Sort link is where you add a Sort Name, Description, and Sort Type. Click Save.

You can search for names by entering part or all of a name, and selecting a sort. Click Go.
You can **re-sort** your portrait images by grade, teacher or homeroom. If you have already flowed your portraits, this function will clear your portraits from the page(s) they were previously on.

You can **add a new name** while you are in a sort by clicking “Add New Name,” which takes you to the portrait details screen.

The **Borders/Backgrounds/Clip Art** area lets you view page graphic options provided by Lifetouch. This area also includes folios, which are small graphic elements designed to be placed near the page number.
The **Template Library** is where you can access the templates you created, along with template options provided by Lifetouch. If you check “Add to Favorites” under the template thumbnail you can easily find it by searching for “favorites” while creating pages. Reference page 53 for details.

**Activity templates** are listed by category to help you easily find what you need. **Portrait templates** are listed by headsize.

**Custom templates** are created by clicking “Create Template” and entering a name, type, and layout it should be based on. When creating custom templates, you can add elements, change the shape of existing elements, or remove existing elements.

**FYI: CREATING CUSTOM PORTRAIT TEMPLATES**

- **The page creation workspace** is where Portrait Template customization occurs.
- **You can un-check portrait boxes** that you don’t want to appear on the page.
- **The properties of the portrait boxes are editable.** You can change the border, shape and size/position of the portrait box.
- **You can add and edit other page elements** such as images, text boxes, shapes and lines. After adding elements, you may edit the shape, fill, border, drop shadow, and size/position of those elements.
- **When you are ready to use your custom template** for a page, select a page number then select the template from your custom template library.
The **Index Library** tool lets you easily organize names for your Index (if your yearbook will have an Index). In this section you can:

- **Index by Last Name**: Generates a report of how the Index will look if organized by Last Name.
- **Index by Page**: Generates a report of how the Index will look if organized by page.
- **Search for Name**: Search for any individual by Last or First Name.
- **Add Name to Index**: Manually enter names that were not identified in the Image Library, imported from the Portrait Library or imported from a separate spreadsheet.
- **Export Names from Index**: Export Names to InDesign if you choose to build your Index pages in that program.
- **Create Index**: Allows you to flow your index onto your yearbook pages.

---

**FYI: METHODS OF ADDING NAMES TO YOUR INDEX**

Names can be added to your index in several ways:

- **Names can be manually added in the Image Library** by selecting “Names for Index.” Each time the image is placed on a page, the names in this field will be flagged for the Index.
- **Names will be automatically added** from the portrait names after a sort is flowed.
- **Names can be manually entered directly** into the Index Editor.
- **Names can be added when creating pages** by highlighting a name on the page and selecting “Add to Index” in the Element Actions menu.
- **Names can be imported from a spreadsheet** (cvs file).
To edit names in your Index, click the box in front of each name to view the details and make changes.

If you have duplicate names that refer to the same person you can merge the two names and make them one entry as long as one of the names is associated with a portrait. Just click the box in front of both names, then click “Continue” and pick the version you want to display in your index.

When you are ready to format the index, click “Create the Index” and complete the required fields. After selecting the number of columns, the site will then indicate which pages are available to flow the Index onto. If you do not have enough consecutive empty pages to flow the index, clear the contents of the pages that you would like your index on, or increase the number of columns you want in your Index.
The Build tab in Book Creation is where your pages come to life. You can select templates, insert elements, enter text, apply styles, adjust element properties and more.

In the Book Creation section, the main part of the page is called the “workspace.” Above and to the left of the workspace is where you will find the page creation tools located within Control Palettes, Icons and Menus.

**FYI: PAGE ICONS & CONTROL PALETTES**

The Build tab contains a set of powerful Control Palettes. The Control Palettes provide the tools needed to create yearbook pages.

1. **Template**: View and select the template you want to start from, and view key details about the page.
2. **Image**: Get quick access to the photos and artwork in your Image Libraries.
3. **Text**: Control text attributes including: style, font, size, color, and more.
4. **Add Elements**: Add images, text boxes, shapes and lines.
5. **Properties**: Edit the shape, fill, border, drop shadow, and size/position.

**FYI: ACTION ICONS**

The top of the workspace includes icons that give you one-click access to useful actions.

1. **Save**: The “Save” icon allows you to save the current page.
2. **Cut, Copy and Paste**: These icons enable you to complete the actions in one click.
3. **Undo and Redo**: If you change your mind as you are working, you can “undo” the last several actions made on the page. After you undo one or more actions, you can “redo” those same actions.
4. **Spell Check**: This icon initiates the spell check process.
5. **Zoom In and Zoom Out**: These icons let you make the page bigger or smaller in size. The more you zoom in, the bigger the elements are. Zooming out will bring more of the page into the workspace.
Several menus are available at the top of the workspace. These menus make it easy to make page actions, and adjust the way the page looks on the screen.

**FYI: “PAGE ACTIONS” MENU**

The Page Actions menu allows you to complete many important activities related to the page you are working on. This menu includes:

- **Save**: Saves the work you have done on a single or double-page spread. It’s good to get in the habit of clicking this menu item (or the “Save” icon) every few minutes.
- **Save As Custom Template**: Saves the current page as a template, which makes it easy to create a similar template on a different page.
- **Clear Contents**: All text and photos within page elements will be deleted from the page. The template, elements and any locked elements, will remain.
- **Clear Template & Contents**: All text and photos, page elements AND the template will be deleted from the page. If you want to change the template on a page that is already in progress, you have to start by taking this action. After the template is cleared, you will be able to select a new one in the Template Selection Control Palette in the Template tab.
- **Columns**: You can add up to eight non-printable column guides, which will help you keep page elements in alignment.
- **Revert to Saved**: This action returns the page to the way it looked the last time you saved it.
- **View as Left Page Only**: The workspace will only show the left half of the page spread.
- **View as Right Page Only**: The workspace will only show the right side of the page spread.
- **Highlight**: You can highlight the Master Page Elements or Spot Color Elements, so you can easily see where those elements are located on the page.
- **Spell Check**: This will initiate the Spell Check process, so you can make sure that all of the words on the page are spelled correctly.
FYI: ‘PAGE ACTIONS’ MENU

- **Find/Replace:** This will open the Find and Replace window, which allows you to search the page for specific text and replace it with something else.
- **Request Creative Services:** If you have any special requests for Lifetouch to do something special when they print this page, you can add a note here.
- **Zoom In:** The page will enlarge in size, centering on the location of your mouse click.
- **Zoom Out:** The page will decrease in size, which will bring more of the page into the visible workspace.
- **Mirror Page:** This action duplicates all of the elements of one side of the page spread, and places them on the opposite side of the page spread in the reverse location.
- **Apply Template Flip:** This action duplicates all elements on a page and flips them into reverse location on the same page.

FYI: ‘ELEMENT ACTIONS’ MENU

The Element Actions menu enables you to perform actions on a specific element that is on the page.

- **Clear Contents:** The content that is contained within the selected element will be deleted, but the element will remain.
- **Delete:** The selected element will be deleted from the page.
- **Order:** You can change the layer of the selected element by bringing it in front or behind other overlapping elements.
- **Align:** You can select multiple elements, and use this function to make them line up in a particular way.
- **Lock/Unlock:** The selected element(s) will toggle between “locked” and “unlocked” status.
- **Group/Ungroup:** Multiple elements can be grouped together, and groups can be divided back into separate elements.
- **Add to Index:** The selected names or text will be included in the Index.

FYI: VIEW MENUS

In the upper right corner of the workspace you will find several View Menus. These menus allow you to:

- Show or hide Guides and Grids
- Activate or de-activate snap options.
- Adjust the size of your page within the workspace. You can zoom in or out by selecting 50%, 75%, 100%, 200%, 400% or “Fit to Page.”
To get started creating pages, the first thing you must do is **Apply Templates**. After a template has been applied to a page, you’ll have access to all of the powerful page editing tools you need to create the page.

**HOW TO: SELECT A PAGE TEMPLATE**

1. Go to a blank page in your book.
2. **Click the Template icon** in the left column, if it isn’t already open.
3. **Define the template type** you are looking for. First, decide if this is an Activity Page or a Portrait Page. Then enter some or all of the available search options (position, library personality, etc.). WebEase customers must search for either right or left templates by using the L or R icons.
4. **Click the “View Templates” button** to have the system search for the options that match the selections you made in the search menus.
5. **Browse the available templates** by scrolling down the left column.
6. **Select a template and drag it onto the page**. This will apply the template to the page and you can view the details at full size.
7. **Save the page** to complete the process.

**HOW TO: CHANGE A PAGE TEMPLATE**

If you want to **change the template** on a page that already has a template, follow these steps.

1. **Go to the page** that you want to change.
2. **Select “Clear Template & Contents”** from the Page Actions menu above the workspace. Keep in mind that if you already have placed text or images on the page, it will delete those page elements.
3. **Follow steps 3-7 from How To: Select a Page Template** above.
**FYI: USING PAGE TEMPLATES**

- **Custom Templates**: If you have a page template that you want to duplicate in other places in the book, you can “Save as Custom Template” by clicking the icon or selecting that option in the Page Actions menu.

- **Favorite Templates**: If there are certain templates you use frequently in the book, you might find it helpful to mark them as “Favorites” in the Template Library. After a template has been marked as a favorite, you will be able to quickly find it in the Favorites category.

- **Template ID numbers**: Each template has a unique ID number. If you know the number of the template you are looking for, you can enter the number in the search options to go directly to it.

- **Left and Right Page Templates**: Some templates are designed specifically for the left or right side of the page spread. If a left page template is selected for the right side of the page spread (or vice versa), the system won’t let you apply the template. You’ll have to search for a template that is designed for the side you are building.

- **Changing a page that already has a template**: If you want to change a page that already has a template, you can use the Page Actions menu to select the type of change you want to make. To change the contents of the page but retain the current template, choose “Clear Contents” or “Revert to Saved.” If you want to start over with a new template, select “Clear Template & Contents” (keep in mind that this will also clear any text or images that have been placed on the page).
The Page Details include several items to help you stay aware of important information:

**FYI: PAGE DETAILS**
- **Type:** Displays the type of page it is (Activity, Portrait, Custom Activity, Custom Portrait, or Blank)
- **Template:** Displays the name of the template.
- **Master Page:** Indicates which Master Page has been applied to the page, if any.
- **Color:** Shows if the page is black & white or full color, according to the Color Assignment settings. Volumes users might also have the option of spot color.
- **Status:** Shows the page’s current status (Not Started, In Progress, Submitted to Adviser, Submitted to Lifetouch, In Production, or Needs Adviser Approval).
- **Proof:** Provides a link to a proof of the page, if one is available.
- **Assigned To:** Displays the name(s) of individuals assigned to the page.

After you have assigned a template to a page, you will be able to place images onto the page.

**HOW TO: PLACE IMAGES ON A PAGE**
1. Go to the page you want to work on.
2. Click the Images icon in the left column, if it isn’t already open.
3. Browse your Image Library by selecting the category of image you want (Images, Portraits, Borders/Backgrounds/Clip Art), then “view all” or browse through the sub-libraries and image thumbnails.
4. Find the image you want by scrolling through the thumbnail images.
5. Drag the image to the box you want to place it in. Click and hold the image as you drag it to the image box, then release it.
6. Repeat these steps until you have finished placing images.
7. Save the page to complete the process.
**HOW TO: RESIZE & MOVE IMAGES**

1. Double-click the image box to go into “edit mode.”
2. Make your desired adjustments to the image’s size and location:
   - Use the scroll bar on your mouse to zoom in or out of the image.
   - Click the Properties icon and use the Resize function under Image Effects.
   - Double-click on the image and use the Zoom In / Zoom Out scroll bar above the image.
3. Click off the image box to exit “edit mode.”
   If the result isn’t quite right yet, repeat steps 1-3 until you have achieved the image size and position you want.
4. Save the page to complete the process.

**FYI: PLACED IMAGES**

- **Image usage details:** After you save a page with images, the site will automatically update the image library area to show that the image has been placed on that page.
- **If an image is too small:** If your image is too small for the image box that you are placing it in, you will receive a warning that the quality of the image will be affected. If you see this warning, we recommend that you make the image box smaller or use a different image.
- **If an image is enlarged too much:** If your image has been resized to the point of being enlarged too much, you will receive a warning that the quality of the image will be affected. If you see this warning, we recommend that you make the image smaller within the box, or use a different image.

**Image details** are available for each image after it is placed on the page. The Image Details control palette shows the file name, maximum print size, usage, library and keywords.
**APPLYING BACKGROUND AND BORDERS**

Backgrounds can be applied to your pages to fill the whole page with an image or pattern that page elements can be placed on top of. WebEase users can also apply page borders.

**HOW TO: APPLY BACKGROUND AND BORDERS**
1. Go to the page you want to work on.
2. Click the Images icon in the left column, if it isn’t already open.
3. Open the Backgrounds/Borders Library and select the background or border you would like to use.
4. Click “Apply Background” or “Apply Border” to place the design on the page. If you change your mind about the selected image, click “Remove Background” or “Remove Border” button to remove the design from the page, then select a different design.
5. Save the page to complete the process.

The Text icon allows you to add and change the text elements on the page.

**HOW TO: INSERT TEXT**
1. Go to the page you want to work on.
2. Click the Text icon in the left column, if it isn’t already open.
3. Double-click the text box you want to work with.
4. Type your text or copy and paste it from a text document open on your computer. If the box already has placeholder text in it, the text will automatically be removed when you begin typing.
5. Make sure there isn’t a red “X” at the end of your text because this means that the length of the text exceeded the size of the box. If you see a red “X” you must make the text shorter or smaller, make the box bigger, or add linked text boxes until the red “X” disappears.
**HOW TO: TEXT FORMATTING**

- **How to link text blocks:** If there is a red “X” in the bottom right corner that means the text is too long for the box. The text can be linked to another box, and it will automatically flow from one box to the next. To two or more text boxes together, click the red “X” and wait for the cursor to change to “+.” then draw a box to create another text box. Repeat this process until all of your text is visible.

- **How to apply color to text:** Highlight the text on the page, and then select a new color from the color palette in the Color & Effects Control Palette.

- **How to make a text box transparent:** Select the text block, then click the Properties tab. In the Fill control palette, select “None” to make the text box transparent.

- **How to add color to a text box:** Select the text block, then click the Properties icon. In the Fill section, select a new color and/or tint from the color palette.

- **How to find and replace words:** You can select “Find and Replace” in the Page Actions Menu to find a specific word or phrase on the current page or double page spread. If desired, you can automatically replace each instance of the word or phrase with a new word or phrase.

- **How to review color choices:** Do not rely on the colors shown on your computer monitor. Instead, refer to the Color Sampler in your kit to see actual printed samples of the predefined colors.

The *Font* Control Palette is where you can change the font attributes of the entire text box, or just a highlighted section within the text box.

**FYI: FONT ATTRIBUTES**

When you first enter text, it will default to the style you assigned in Styles & Settings. You can either keep it as the default style, or you can manually change one or more of these attributes:

- **Style:** Changing the Style attribute will change the entire text box to match the font, size, color and all other attributes of the selected style.

- **Font:** Changing the Font attribute will change the font of the text, but will retain the original size, color, and other attributes of the original text.

- **Font Style:** You can change the font style to make the selected text bold, italic, underlined, or add a drop cap. Clicking these icons will toggle the attribute on and off.

- **Size:** Changing the Size attribute will make the text bigger or smaller.
COLOR & EFFECTS

The Color & Effects control palette lets you change several visual attributes of the text.

FYI: COLOR & EFFECTS ATTRIBUTES

- **Color:** You can adjust the color of the text by selecting a new color in the color palette.
- **Tint:** If you don’t want the text to be in solid color, you can type in a specific percentage or use the slider bar to adjust the tint of the color. The higher the number, the darker the text.

SPACING & ALIGNMENT

The Spacing & Alignment control palette is where you can adjust several text attributes to achieve the typographic effect you want.

FYI: SPACING & ALIGNMENT ATTRIBUTES

- **Alignment:** The Alignment attribute determines the left-to-right placement of the text within the box. Text can be aligned to the left, centered, aligned to the right, or justified. “Left alignment” or “Right alignment” means one side will be aligned and the other side will be ragged. “Centered” means all lines will align down the middle of the text box. “Justified” means the lines will be aligned on both the right and the left by spreading or compressing the text on each line.
- **Leading:** The Leading attribute determines the amount of space between each line of text. The larger the number, the more space there will be between lines.
- **Kerning:** The Kerning attribute determines the amount of space between specific letters. If kerning is “on,” the system will automatically adjust the kerning settings between pre-programmed letter pairs, so the spacing looks even to the reader. If kerning is set to “none,” all letters will have the exact same amount of space between them.
- **Tracking:** The Tracking attribute adjusts the amount of space between letters or words. If tracking is set to “none,” the words will be spaced according to the normal font settings. Increasing the number will increase the space between letters or words.
- **Margin:** The Margin attribute adjusts the amount of space between the text and the outside of the text box.
The **Special Characters** control palette makes it easy to add unique text characters. Just place your cursor in the spot you would like the special character to be located, and then click the desired character from the list in the control palette.

The **Add Elements** icon is where you can create new elements and bring visual interest to your page. The element options are grouped into three categories:

- **Image Elements** are boxes and other shapes that can contain images.
- **Text Elements** are boxes that can contain text.
- **Shapes & Lines** are elements that can add visual interest to the page (but can’t contain images or text).

**HOW TO: ADD ELEMENTS**

1. Go to the page you want to work on.
2. Click the Add Elements icon in the left column, if it isn’t already open.
3. Identify the element you want by viewing the options in the Image Elements, Text Elements, and Shapes & Lines groupings.
4. Add the selected element to the page through one of two methods:
   - Click the element, then click the page and drag the cursor to define the size of the element.
   - Drag and drop your selected element onto the page. Then, adjust the size by dragging the corners of the element box.
5. Repeat these steps until you have finished adding elements.
6. Save the page to complete the process.
**Properties**

The Properties icon is where you can apply image effects, change shapes, fill shapes, apply line borders to elements, and adjust the size and position of placed elements. The Image Effects control palette is only available when you have an image selected on your page.

**Image Effects**

The Image Effects control palette enables you to enhance and manipulate your photos and other images.

**FYI: Image Effects**

- **Color**: Lets you change the image from full color to sepia tone or black & white.
- **Ghosting**: Adjusts the brightness of the image in 10% increments.
- **Fade**: Allows you to apply a light, medium or heavy fade to the edges of the photo.
- **Resize**: Adjusts the size of the image within the image element between 1% and 200% by moving the slider bar or typing a percentage directly into the Resize box.
- **Reposition**: Lets you drag the image to the desired position within the image box.
- **Rotate**: Changes the rotation of the image within the element box by typing a specific rotation in the box, or rotating in 90-degree increments (clockwise or counter-clockwise).
- **Flip**: Mirrors the image vertically (top to bottom) or horizontally (left to right).

**Shape**

The Shape control palette allows you to change the shape of your selected object by clicking a different shape within the palette.
The Fill control palette lets you fill any element with color. You can also adjust the tint if you don’t want the color to be solid.

The Border control palette allows you to add a border to an element, and give it specific attributes.

**FYI: BORDER ATTRIBUTES**

- **Size:** The point size for your border can be 1, 3, 5, 9 or 13
- **Color:** The border can be any color within the color palette.
- **Style:** The style of the border can be solid, dashed or dotted.
- **Tint:** The tint of the color can be adjusted if you don’t want the border to be 100% of the color.

The Drop Shadow control palette is where you can add a drop shadow to a selected element. Just click “Shadow” in the Drop Shadow Control Palette, and adjust the drop shadow attributes. Shadows are only allowed on text when the text box is not filled. As soon as you add a fill to a text box, the shadow moves from the text itself to the text box.

**FYI: DROP SHADOW ATTRIBUTES**

- **Color:** The drop shadow can be any color within the color palette.
- **Tint:** If you do not want the drop shadow to be 100% of the color, you can type in a tint value, less than 100% or use the slider bar.
- **Position:** Indicate the position of the drop shadow by dragging the black square to the desired location. As you are moving it, you will see a preview of where the drop shadow will be placed.

The Size & Position control palette is where you can adjust the size, position, rotation and other attributes of the selected element.
**KEYBOARD SHORTCUTS**

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Save Page</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Add Item Mode</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Cut to Clipboard</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy to Clipboard</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Templates Control Palette</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Images Control Palette</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Text Control Palette</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Add Element Control Palette</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Properties Control Palette</td>
<td>Ctrl+5</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl++</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl+-</td>
</tr>
<tr>
<td>Move Selection</td>
<td>Arrow keys</td>
</tr>
<tr>
<td>Move Content</td>
<td>Arrow keys</td>
</tr>
<tr>
<td>(in content manipulation mode)</td>
<td></td>
</tr>
<tr>
<td>Delete Selection</td>
<td>Del</td>
</tr>
<tr>
<td>Group Selection</td>
<td>Ctrl+Shift+G</td>
</tr>
<tr>
<td>Ungroup Selection</td>
<td>Ctrl+Shift+U</td>
</tr>
<tr>
<td>Rotate Mode</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Send Selection to Front</td>
<td>Ctrl+Shift+F</td>
</tr>
<tr>
<td>Send Selection to Back</td>
<td>Ctrl+Shift+B</td>
</tr>
<tr>
<td>Open Save As Dialog</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Rotate 270 Degrees</td>
<td>Ctrl+Shift+E</td>
</tr>
<tr>
<td>Rotate 90 Degrees</td>
<td>Ctrl+Shift+T</td>
</tr>
<tr>
<td>Flip Shape Horizontal</td>
<td>Ctrl+Shift+H</td>
</tr>
<tr>
<td>Flip Shape Vertical</td>
<td>Ctrl+Shift+V</td>
</tr>
<tr>
<td>Fit to Screen</td>
<td>Ctrl+Shift+W</td>
</tr>
<tr>
<td>Multi Select Mode (while shift key pressed)</td>
<td>Shift</td>
</tr>
<tr>
<td>Bold (in content manipulation mode)</td>
<td>Ctrl+Shift+B</td>
</tr>
<tr>
<td>Italic (in content manipulation mode)</td>
<td>Ctrl+Shift+I</td>
</tr>
<tr>
<td>Underline (in content manipulation mode)</td>
<td>Ctrl+Shift+U</td>
</tr>
<tr>
<td>Align Center (in content manipulation mode)</td>
<td>Ctrl+Shift+E</td>
</tr>
<tr>
<td>Align Left (in content manipulation mode)</td>
<td>Ctrl+Shift+L</td>
</tr>
<tr>
<td>Align Right (in content manipulation mode)</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Justify (in content manipulation mode)</td>
<td>Ctrl+Shift+J</td>
</tr>
<tr>
<td>Shape Distortion Mode</td>
<td>Alt+Double Click</td>
</tr>
</tbody>
</table>

* Mac users should use the **Cmd** key in place of **Ctrl**.
To view pages properly, you may need to adjust the default settings in your Web browser. First, you should make sure you are using a supported browser.

**HOW TO: CONFIRM YOUR BROWSER MEETS SITE REQUIREMENTS**

- **If you are using Internet Explorer**, open a browser window and select “About Internet Explorer” in the Help menu. If it tells you that you are using a version older than 6.0, you will need to download the latest version from the Microsoft® Web site.
- **If you are using Firefox**, open a browser window and select “About Mozilla Firefox” in the Firefox menu. If it tells you that you are using a version older than 2.0.4, you will need to download the latest version.

**HOW TO: ADJUST YOUR SETTINGS - CACHE**

To view pages properly, you may need to adjust the default settings in your browser.

**INTERNET EXPLORER v5.5 & 6.0 - WINDOWS**
- With your browser window open, go to Help > About Internet Explorer and confirm the version number is v5.5–6.0 or higher.
- If you have an older browser version, you can download the latest version from the Microsoft® Web site.
- Go to Tools > Internet Options. From the Temporary Internet Files area, click Settings.
- From the Check for newer versions of stored pages area, select Every visit to the page.
- Click OK on the Settings window and OK again to close the Internet Options window.

**INTERNET EXPLORER v7.0 – WINDOWS**
- With your browser window open, go to Help > About Internet Explorer and confirm the version number is 7.0.
- Go to Tools > Internet Options. From the Browser History area, click Settings.
- Click OK on the Internet Options dialog box. In the “Temporary Internet Files and History Settings” dialog box, look at the top for the setting to Check for newer versions of stored pages: and then select Every time I visit the webpage.
- Click OK on the “Temporary Internet Files and History Settings” and OK again to close the Internet Option.
**HOW TO: ADJUST YOUR SETTINGS - CACHE**

**FIREFOX – WINDOWS AND MAC**

- Type about: config in the address box and click Enter.
- Look for the preference name browser.cache.check_doc_frequency.
- Double click the preference name browser.cache.check_doc_frequency to open the Enter integer value dialog box.
- Enter the value 1 and click OK to close the dialog box.

**ADJUSTING COMPUTER SETTINGS – COOKIES**

Each time you sign into your account, a temporary cookie (small text file) is stored on your computer. When you sign out or close the program, the cookie is removed. If you keep returning to the Sign In screen, even after you’ve entered the correct user information, you might need to reset your browser to allow cookies.

**HOW TO: ALLOW COOKIES PC**

**Internet Explorer v6.0 & v7.0**

1. Go to Tools and select Internet Options
2. Go to the Privacy Tab and set the Internet Zone to “Medium” or “Low”.
3. Click “Advanced” and select both “Override automatic cookie handling” and “Always allow session cookies”.
4. Click “OK” to close the Advanced Privacy Settings window.
5. Click “OK” again to close the Internet Options window.

**Firefox on a PC**

1. Go to Tools and select Options.
2. Go to Privacy.
3. Find Cookies and select “Accept cookies from sites”.
4. Click “OK” to save changes.
HOW TO: ALLOW COOKIES MAC

Firefox on a Mac
1. Go to the Firefox menu and select Preferences.
2. Select the Privacy tab.
3. Go to Cookies and select “Accept cookies from sites”.
4. Click “OK” to save changes.

Safari on the Mac
1. Select Preferences from the Safari menu.
2. Click the Security icon near the top of the window.
3. Go to Accept Cookies and make sure either the “Always” or “Only from sites you navigate to” option is selected.
COMPUTER MEMORY (RAM)
The site recommends at least 1GB of RAM or higher (memory) to operate. If you are having trouble saving, or if your computer locks up, you may need to increase the memory allocation.

HOW TO: CHECK YOUR RAM
PC
1. Click Start and select Settings
2. Go to Control Panel in the Task Bar.
3. Double-click “System”.
4. Go to General tab to view the RAM and operating system.
5. Click Cancel to close the System Properties window, then close the Control Panel window.

MAC
1. Open the Apple menu (click the little apple in the upper left corner of the screen). Choose either About This Mac or About this Computer.
2. Look for the Total Memory Line.
MONITOR RESOLUTION
The site is designed to work best at a resolution of 1280 x 1024, but it will also work at a resolution of 1024 x 768.

HOW TO: SET MONITOR RESOLUTION
PC
1. Go to Start and select Settings.
2. Go to Control Panel and double-click the blue Display icon.
3. Go to the Display Properties window, and then the Settings tab.
4. From Screen Area, move the slide bar to the right toward the “More” label, until it is set at either 1024 x 768 or 1280 x 1024.
5. Click Advanced and select the General tab.
6. From the Font Size area, select Small Fonts from the drop-down list.
7. Click “OK” to exit each window.

NOTE: You may have to click “OK” a few times while Windows resets your monitor settings.

MAC
1. Open the Apple menu (click the “apple” logo in the upper left corner of the screen).
2. Select Systems Preferences
3. Select the Displays icon.
4. Select either the 1024 x 768 setting or the 1280 x 1024 setting and your monitor will automatically adjust to the new setting.
NOTES:

FYI: TIPS TO PREVENT PROBLEMS

- **Anti-Spyware:** For the best experience with our website, we recommend that you install Anti-Spyware software on your computer. Anti-Spyware is security technology that helps protect Windows users from spyware and other potentially unwanted software. You can get anti-spyware software at www.microsoft.com

- **Pop-ups:** Lifetouch uses Pop-ups throughout the website. If you use Pop-up blocker software, you must configure it to accept the following domain: http://onlineyearbooks.lifetouch.com

- **Firewalls:** If you use a firewall, you must configure it to accept the following domain: http://onlineyearbooks.lifetouch.com. Contact your Network Administrator to verify the firewall is not drastically slowing down Internet connections. If your connections are too slow, you could time out during certain requests, like uploading photos. Also, verify that the configuration will let you access and receive information from Lifetouch Web sites.

- **Spam Filters:** To ensure you receive important e-mails from Lifetouch, add lifetouch.com to your approved e-mail list.

- **Printing Pages:** Change margins if you have trouble fitting images on a page when printing. Go to File > Page Set-Up and adjust the margins accordingly (e.g., 0.5” on each side).

FYI: GOOD PRACTICES

To eliminate some common issues when accessing the site, you should:

- **Close all unnecessary applications,** especially applications that require a lot of resources such as an Internet radio.

- **Save your work often,** approximately every 15 minutes.

- **Don’t wait until the last deadline** to upload all images, create pages and view proofs. The weeks before the last deadline is a busy time for Lifetouch servers, causing the server response time to be slower than during off-peak times.
HOW TO: TROUBLESHOOT A TECHNICAL PROBLEM

- Determine where the problem stems from (computer hardware, configuration or from the school’s network).
- If a process worked before, but doesn’t now, check whether anything has changed on the computer or school’s network. Has a new application been installed, or changes made to the computers network or firewall? You might need to contact your System Administrator for information.
- Try a different computer and see if the problem is replicated. If not, the problem is most likely isolated to the one computer. Contact your Network Administrator for help.
- Check the bandwidth on your network by using an Internet search engine to search for “connection speed” (These sites are trying to get you to buy a tool, but often they will give you one free test of your Internet connection). DSL connections typically have a bandwidth of 768 kbps and cable connections are typically 1.5 mbps.
- Upload images, create pages, and view proofs intermittently, rather than all at once right before the deadline. If possible, work on the yearbook when there is low activity on the school’s network.
- Contact your ISP if you are getting dropped from the Web site, your connection speed is slow, or you have determined (to the best of your ability) it is not an issue related to your computers or network. It will be most helpful if you can provide them with the following information:
  - What time the error/issue occurred.
  - The exact error message, if you received one. Take a screen shot of the error message so you have it for reference or can e-mail it if requested.
- Contact your Lifetouch Customer Care representative if your ISP is unable to troubleshoot your issue. Provide the following information:
  - What time the error/issue occurred.
  - Which screen you were working on and/or the exact error message (to print the error message: click the “Print Screen” button on the upper right hand side of your keyboard, so you have it for reference or can e-mail it if requested.)
  - Indicate whether multiple users experience the issue.
A Year in the Life (Volumes)/A Year in Review (WebEase): A 16-page, full color year-in-review insert that can be stitched or taped in the yearbook. It features the year’s biggest news stories, sports achievements and hottest entertainment buzz.

Account Executive: Your Lifetouch contact for questions or assistance.

Activity Photo: Any photo that is not a portrait. Activity photos include un-posed (candid) subjects or posed subjects such as club, team or class photos.

Adobe®Reader®: The software program that the site uses to view PDF proofs of yearbook pages.

Adviser: Person (usually a teacher or school representative) who directs the yearbook process at the school from start to finish.

Alignment: Bringing letters of a line of type together into exact position—either left justified, centered, right justified, justified or full justified.

Approve: To accept the page you have submitted to Lifetouch, or to accept the changes that Lifetouch made to your page, according to your special instructions.

Artwork: Photographs, drawings, hand lettering and line art, which is prepared for illustration on a yearbook page.

Aqueous Coating: A glossy, environmentally-safe coating on soft cover yearbooks.

Background: Design, pattern or image used to fill and enhance the yearbook page design.

Baseline: The line on which all letters rest.

Base Color: The first color used as a background on which other colors are applied.

Candid Photo: An activity photo in which the subjects are informal, spontaneous, and not posing.

Caption: Text located near a photo that explains what is happening in the photo.

Clip Art: Graphical artwork used to enhance the yearbook.

CMYK (Cyan, Magenta, Yellow, and Black): The four colors used in the printing process.

Close Register (or Tight Register): Required when photos and artwork, screens or rule-lines are butting each other.

Copy: Text in a book. It can be body copy, caption copy or headline copy.

Credit Line (or Byline): A statement giving the name of the person responsible for a picture or copy.

Crop: To eliminate (opaque, mask, cut or trim) portions of an illustration or photo to fit a specific area, or to capture only a portion of the photo on a yearbook page.

Custom Template: Original page templates created by a school.

DPI (Dots Per Inch): Used to measure resolution for scanning and printing. Generally, more dots per inch means a higher resolution, a greater amount of visible detail in the image, and a larger file size.

Deadline: Date by which pages, cover designs or other production-related materials are due at the publishing plant.

Digital Image: A photo composed of pixels (captured on a digital camera, scanned or created from scratch with image-creation software).

Double-Page Spread: A spread with cross-gutter elements.

Download: To take photos from a digital camera and transfer them to a computer. Can also mean transferring files from an e-mail or from a website to your own computer.

Em Space: A printer’s unit of space measurement equal in width to the letter “m” in the selected type size.

Endsheets: Sheet of heavy text stock paper that is used to attach the inside pages of a hard cover yearbook to the cover. One half of the endsheet is adhered to the inside cover, while the other half creates a page in the book.

Enlargement: A reproduction larger in size than the original.

EPS (Encapsulated PostScript): An Adobe graphic file format. If graphics do not export or import well as a TIFF (Tagged Image File Format), EPS is another option. EPS translates graphics and text into a code that the printer can read and print.

Error Message: A message you receive when there are technical difficulties with the Internet connection or an action you are trying to make.
Export: A process to create a file in a format that is compatible with other applications. This option can usually be found under the File menu in most graphics software applications.

Finish: The surface property of a sheet of paper, such as gloss or matte.

Firefox: A web browser available on PCs and Macs (this site supports v2.0.0.2 and v2.0.0.4).

Flowing: Arranging the portraits on the page. Once you have finished proofing your portraits and you have selected enough pages for each of your sort values, you will be asked to flow your portraits onto your portrait pages.

Flush: Usually refers to typeset copy that is even with the margin or photo box.

Flush Left: Refers to typeset copy that is straight on the left edge of the printing or text area.

Flush Right: Refers to typeset copy that is straight on the right edge of the printing or text area.

Foil Imprinting: Tissue-thin material faced with metal or pigment used in book stamping with stamping dye. Foil Imprinting has a high gloss, metallic shine. Foil Imprinting is available in a variety of colors.

Fold-Out: A page that exceeds the dimensions of a single page. It is folded to page size and included in the book, sometimes bound in and sometimes tipped (pasted) in. Available in Volumes only.

Folio: Small graphic elements designed to be places near the page number.

Font: An assortment of type of one size and face containing all of the characters needed for ordinary composition. The term refers generically to letter styles.

Four-Color Process: A reproduction of color made by means of photographic separations. Four-color printing uses cyan (blue), magenta (red), yellow and black inks, each requiring its own plate. This is the means of four-color reproduction in printing.

Full-Color: Another term for four-color process. A reproduction of color made by means of photographic separations. Four-color printing uses cyan (blue), magenta (red), yellow and black inks, each requiring its own plate.

Gloss: Surface quality of paper that reflects light.

Gutter: Short for Gutter Margin – the margin in the middle of a double-page spread.

HTML (Hypertext Markup Language): A programming language for websites that can incorporate text, graphics, sound, video and hyperlinks.

Hairline: A line used on templates to indicate the position of a photo or copy. The line is typically not printed in the final yearbook.

Headline: Words set at the head of a page to introduce or categorize.

Headsize: The size of the portrait box that the portrait images will be placed in.

Hot Foil: Tissue-thin material faced with metal or pigment used in book stamping with stamping die. Hot Foil has a high gloss, metallic shine. Hot Foil Namestamping is available in a variety of colors.

Internet Explorer (I.E.): A web browser available on PCs and Macs (this site supports v6.0 and v7.0 on the PC only).

Image: Any picture, clip art or scanned text that can be placed in a photo box.

Italic: Style of letters that slope forward, often used for words requiring emphasis.

JPEG (Joint Photographic Experts Group): A bitmap file format that uses compression to make images take less file space.

Justify: To set type or prepare text composition to a specified width or measure so that the left and/or right-hand margins of the printed matter will be aligned. Justification may be accomplished by adjusting the spacing between words and characters to fill the measure with each full line of type.

Kerning: Adjusts the preset space between pairs of letters. Kerning takes away some of the space between letters to create a more visually pleasant configuration. Kerning is strictly proportional so that the space gets bigger or smaller at the same rate as the characters.

LPI (Lines Per Inch): A unit of measurement used to describe resolution by specifying the number of lines that are printed in an inch. The higher the number of lines, the higher the print quality.
**Ladder Diagram**: A planning tool used to plan the contents of each page of the yearbook—an important first step in designing the yearbook.

**Leading**: The space between lines. You can change leading if you want to increase or decrease the space between lines of text.

**Login Information**: The unique and secure information that each user must provide in order to gain access to the site, including the job number, a user name and a password.

**Low Resolution (Lo-Res)**: Low-resolution files require less memory than high resolution files, and are only acceptable for monitor display. Resolution is calculated in “dots per inch” (dpi). A standard low-resolution scan is 72 dpi or 96 dpi. On this site, images appear in lo-resolution on screen, but will be replaced with the high-resolution image when printed in the final yearbook.

** Matte Finish**: Dull paper finish without gloss or luster.

**Modified Type**: Any caption or name that will not show up well if it is reversed or overprinted on a photograph, or if artwork has to be modified to make it readable.

** Montage Page**: Created by pasting overlapping photos onto a Layout Board—a fun way to feature a lot of student photos on a yearbook page.

** Moiré**: Undesirable patterns occurring when reproductions are made from pre-printed material.

**Natural Spread**: Two facing pages in a book that are printed together within a flat. Because they are printed at the same time, photos that extend across the gutter of the yearbook should be placed within a natural spread. In Smythe sewn books, each 16-page signature of the book will include a natural spread (e.g., pages 8 and 9 are a natural spread).

**Pixel**: The smallest units of data in a digital image (the little squares you see when you zoom in on a photo). Together, pixels constitute a digital image. A pixel's code contains information related to color and placement within the larger image.

**Point**: A printer’s unit of measurement used principally for designing type size. There are 12 points to a pica and 72 points to an inch.

**Portrait**: An individual photo of a student or staff member issued in the creation of the portrait pages of the yearbook.

**Proofs**: Files that represent how a page will look in the final book. On this site, page proofs are generated electronically and are viewable with Adobe® Reader®.

**RGB (Red, Green, Blue)**: The color scheme used to display color images on computer monitors.

**Refresh**: An action that re-loads your current web page within the browser window. You should frequently click the “Refresh” button located at the top of your screen to update your page. This is helpful in a situation where someone else might be working on the same section of the book.

**Resolution**: The number of pixels (picture elements) per unit of linear measurement (inch) on a computer monitor, or the number of dots per inch in a digital picture.

**Reverse**: Type appearing in white (color of the paper) on a black or color background, or in a dark area of a photograph.

**Save**: Keeps any changes that you have made to a page.

**Scanner**: An input device that digitizes images, creating digital images that may be manipulated electronically.

**Smythe Sewing**: A book-binding process in which 16-page signatures are folded and trimmed to create a 16-page section. These 16-page sections are stitched together and inserted into the cover.

**Sort Value**: When pictures are uploaded to the site, they are placed in sort values. Portraits are separated into different sort values according to grade, homeroom or teacher ID.

**Square-Back Binding**: A hardcover binding process that uses state-of-the-art production technology to create a flat, durable spine.
Submit: To send your saved work and any special instructions to Lifetouch.

Supplement: An additional insert to capture year-end activities that occur after the early submission deadline. Supplements may be stitched in or include an adhesive strip so that the students can insert it into books after delivery.

Thumbnail: A small preview of a yearbook page, which can be found in the Ladder Diagram and throughout the site. Clicking on the thumbnail will open up the page in the corresponding “builder.”

TIFF (Tagged Image File Format): TIFF files can be color or grayscale. Their resolution or dpi determines the quality of the image. When exporting images for use in QuarkXPress® or InDesign®, choose this format first. If it does not work well, the EPS format should be fine. If using graphics like line art, an EPS file format is recommended instead of TIFF.

Tint: A screened-back version of a pure color, measured in a percentage amount. Full color is 100%, and a tint is a version of that color that is less than 100%.

Tracking: Determines the amount of space between letters and words. Tracking adjusts the relative space between characters so that it gets slightly tighter at large sizes and slightly looser at small sizes. You can choose to increase or decrease the tracking in increments of five points.

Trim Size: The final size of yearbook page.

Upload: Transferring information from a personal computer to Lifetouch.
# INDEX

## A

- Add Elements to Pages ........................................... 59
- Add Name to Portrait Library .................................. 45
- Add Names to Index .............................................. 47
- Add Sort ................................................................ 44
- Apply Borders and Backgrounds .............................. 19, 56
- Apply Templates .................................................... 52, 53
- Approve Pages ...................................................... 30
- Assign Color Pages ............................................... 17
- Assign Deadlines ................................................... 17
- Assign Spot Color .................................................. 18

## B

- Body Copy ............................................................ 23
- Book Settings ....................................................... 17
- Borders & Backgrounds - Defaults ............................ 19
- Borders & Backgrounds in Build ............................... 56
- Borders for Page Elements ..................................... 61
- Browser Requirements .......................................... 63
- Browser Setup ...................................................... 7
- Build Pages .......................................................... 49-62

## C

- Cache: Adjust your Settings .................................... 63, 64
- Change a Page Template ........................................ 52
- Change Portrait Images ......................................... 42
- Color & Deadline Assignment ................................ 17
- Color & Effects for Text ........................................ 58
- Contact Information .............................................. 5
- Cookies: Allow on a Mac ....................................... 65
- Cookies: Allow on a PC .......................................... 64
- Cover & Endsheets - Volumes ................................. 28
- Cover & Endsheets - WebEase ................................. 26, 27
- Cover Artwork ..................................................... 28
- Cover Book .......................................................... 27
- Cover Proofs ....................................................... 27
- Create a Custom Style .......................................... 22
- Custom Templates ................................................ 46
- Custom Dictionary ............................................... 24
- Customize your Sales Tracker List ........................... 15
- Customize your Site ............................................. 8

## D

- Drop Cap for Text .................................................. 57
- Drop Shadow for Page Elements ............................. 61

## E

- Element Actions Menu .......................................... 51
- Export Portraits from Portrait Library ....................... 44

## F

- Fill Page Elements ............................................... 61
- Font ....................................................................... 57
- Font - Default Selections ..................................... 20
- Fonts - Select your Defaults ................................ 20

## G

- Glossary ............................................................ 70
- Good Practices .................................................... 68

## I

- Icons ..................................................................... 49
- Image Details ....................................................... 39, 55
- Image Effects ....................................................... 60
- Image Libraries .................................................... 38-40
- Image Library - Create new folder ............................ 40
- Image Library - Delete folder .................................. 40
- Image Library - Rename folder ............................... 40
- Image Management ............................................. 35
- Image Usage ......................................................... 41
- Images .................................................................. 54, 55
- Import from previous year ..................................... 7
- Import your Name List .......................................... 24
- Index ..................................................................... 47, 48
- Index – Enter Names in Image Library ....................... 39
- Insert Text ........................................................... 56

## K

- Keyboard Shortcuts .............................................. 62

## L

- Ladder ................................................................. 29
- Link Text Boxes .................................................... 57
- Login .................................................................... 6

## M

- Mail CD’s and Prints to Lifetouch ............................. 37
- Manage Users ...................................................... 12
- Master Pages ....................................................... 31
- Monitor Resolution .............................................. 67
- My Profile .......................................................... 10
- My Tasks ............................................................. 10

## O

- Organize Pages .................................................... 33
- Overall Site Navigation ........................................ 8
<table>
<thead>
<tr>
<th>Page Actions Menu</th>
<th>50, 51</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Control Palettes</td>
<td>49</td>
</tr>
<tr>
<td>Page Details</td>
<td>54</td>
</tr>
<tr>
<td>Place Images on Page</td>
<td>54</td>
</tr>
<tr>
<td>Placed Images</td>
<td>55</td>
</tr>
<tr>
<td>Plan</td>
<td>25</td>
</tr>
<tr>
<td>Portrait Default Settings</td>
<td>19</td>
</tr>
<tr>
<td>Portrait Details</td>
<td>19, 42</td>
</tr>
<tr>
<td>Portrait Flow Guidelines</td>
<td>43</td>
</tr>
<tr>
<td>Portrait Library</td>
<td>42, 43</td>
</tr>
<tr>
<td>Proof Covers</td>
<td>27</td>
</tr>
<tr>
<td>Properties</td>
<td>60</td>
</tr>
<tr>
<td>Video Tutorials &amp; FAQ’s</td>
<td>11</td>
</tr>
<tr>
<td>View Book</td>
<td>25</td>
</tr>
<tr>
<td>View Menus</td>
<td>51</td>
</tr>
<tr>
<td>View Proofs</td>
<td>32</td>
</tr>
<tr>
<td>RAM</td>
<td>66</td>
</tr>
<tr>
<td>Resize and Move Images</td>
<td>55</td>
</tr>
<tr>
<td>Re-sort Portraits</td>
<td>45</td>
</tr>
<tr>
<td>Resources</td>
<td>63</td>
</tr>
<tr>
<td>Yearbook Checklist</td>
<td>9</td>
</tr>
<tr>
<td>Yearbook Deadlines</td>
<td>9</td>
</tr>
<tr>
<td>Yearbook Page Status Report</td>
<td>11</td>
</tr>
<tr>
<td>Yearbook Preview</td>
<td>32</td>
</tr>
<tr>
<td>Sales Tracking &amp; Resources</td>
<td>14, 15</td>
</tr>
<tr>
<td>Search Image Library</td>
<td>41</td>
</tr>
<tr>
<td>Search Portraits</td>
<td>44</td>
</tr>
<tr>
<td>Security Statement</td>
<td>6</td>
</tr>
<tr>
<td>Select a Page Template</td>
<td>52, 53</td>
</tr>
<tr>
<td>Shapes</td>
<td>60</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>12</td>
</tr>
<tr>
<td>Site Preferences</td>
<td>24</td>
</tr>
<tr>
<td>Size &amp; Position of Page Elements</td>
<td>42, 43, 44</td>
</tr>
<tr>
<td>Sort</td>
<td>61</td>
</tr>
<tr>
<td>Spacing &amp; Alignment of Text</td>
<td>58</td>
</tr>
<tr>
<td>Special Characters</td>
<td>59</td>
</tr>
<tr>
<td>Spot Color</td>
<td>18</td>
</tr>
<tr>
<td>Student Frequency Report</td>
<td>11</td>
</tr>
<tr>
<td>Styles</td>
<td>21 - 23</td>
</tr>
<tr>
<td>Submit Pages</td>
<td>30</td>
</tr>
<tr>
<td>System Check</td>
<td>6</td>
</tr>
<tr>
<td>System Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Template Library</td>
<td>46</td>
</tr>
<tr>
<td>Text Formatting</td>
<td>56, 57</td>
</tr>
<tr>
<td>Traffic Report</td>
<td>11</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>63 - 69</td>
</tr>
<tr>
<td>Typography Recommendations</td>
<td>22</td>
</tr>
<tr>
<td>Upload Images</td>
<td>36, 37</td>
</tr>
</tbody>
</table>